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caractéristiques de votre 
nouveau lecteur MP3
Attrayant. Intelligent. Fiable. Et beaucoup de plaisir. Votre nouveau lecteur 
MP3 vous offre tout cela et encore plus. Sa forme compacte se glisse 
facilement dans votre poche et sa technologie de pointe vous offre une 
qualité de son et d’image exceptionnelle et vous permet d’accéder à des 
jeux pleins d’action. Vous adorerez votre nouveau lecteur MP3 ; pendant 
vos exercices, pour télécharger votre musique préférée, visionner vos 
vidéos, jouer à vos jeux, ou même pour écouter la radio FM. Un seul essai, 
et vous vous demanderez comment vous avez pu vivre sans lui.

NOUS AVONS AJOUTÉ LE “MULTI” DANS 
MULTIMÉDIA
Nous l’appelons un lecteur MP3 mais c’est 
encore beaucoup plus. Il vous permet de 
visionner des photos, des textes, des vidéos 
et aussi d’écouter la radio FM et de jouer à 
des jeux.

NAVIGATION TACTILE !
Naviguez dans les menus en touchant 
simplement l’écran tactile.

LÀ OÙ LA FORME RENCONTRE LA 
FONCTIONALITÉ
Bien sûr, il est mince et harmonieux. Mais il 
est aussi facile à tenir et à manipuler.

DURÉE DE LECTURE PROLONGÉE ET DE 
TÉLÉCHARGEMENTS PLUS COURTS !
Une pile complètement chargée peut vous 
procurer jusqu’à 25 heures de musique ou 4 
heures de vidéo.
La durée de téléchargement est plus courte.
Grâce à sa capacité USB 2.0, le lecteur 
est beaucoup plus rapide que les modèles 
utilisant la capacité USB 1.1.

UNE MERVEILLE ACOUSTIQUE
Votre nouveau lecteur MP3 possède l’engin 
DNSeTM (Engin de son naturel numérique), 
une technologie sonore unique à Samsung 
créée pour produire une son plus riche, 
plus profond. Il vous offre une expérience 
d’écoute inimaginable.



consignes de sécurité
Signifi cation des icônes et des symboles contenus 
dans ce manuel :

AVERTISSEMENT
Indique des risques de dommages corporels ou de mort.

ATTENTION

Indique un risque potentiel de dommages corporels ou 
matériels.

ATTENTION

Veuillez respecter les consignes de sécurité suivantes 
afi n de réduire les risques d’incendie, d’explosion, 
d’électrocution ou de dommages corporels lorsque vous 
utilisez votre lecteur MP3 :

REMARQUE

Indique des conseils ou des pages de référence qui 
pourraient vous aider à utiliser le lecteur.

Ne PAS tenter.

Ne PAS démonter.

Ne PAS toucher.

Suivre explicitement les directives.

Débrancher la fi che d’alimentation de la prise murale.

Appeler le centre de services pour de l’aide.

Ces symboles d’avertissement sont là pour vous protéger contre les 
dommages corporels, vous et les autres. Veuillez les respecter à la lettre. 
Après avoir lu cette section, veuillez la conserver pour consultation ultérieure.



consignes de sécurité
Ce manuel décrit le mode d’emploi approprié de votre nouveau 
lecteur MP3. Veuillez le lire attentivement afi n d’éviter de vous blesser 
ou d’endommager le lecteur. Veuillez particulièrement respecter les 
avertissements sérieux qui suivent :

PROTÉGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Ne mouillez pas l’appareil et ne le laissez pas tomber dans l’eau. 
Si le produit devient mouillé, ne l’allumez pas. Cela peut entraîner des 
risques d’électrocution. Contactez plutôt le centre de service à la clientèle 
Samsung le plus proche.

Évitez d’utiliser le produit pendant les orages. Cela peut provoquer une 
risque d’électrocution ou une défaillance de l’appareil.

N’utilisez pas l’écouteur lorsque vous conduisez une bicyclette, une 
automobile ou une motocyclette.
bicyclette, une automobile ou une motocyclette. Dans le cas contraire, vous 
risqueriez de provoquer un accident grave. En outre, son utilisation est interdite par 
la loi dans certaines régions.
Utiliser des écouteurs en marchant ou en joggant sur la route et en particulier sur 
un passage pour piétons peut entraîner un accident sérieux.

Pour votre sécurité, veillez à ce que le cordon des écouteurs ne 
s’emmêle pas dans vos bras ou dans d’autres objets environnants 
pendant vos exercices ou vos marches.

Ne rangez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie, sous peine de provoquer un incendie ou une décharge 
électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTÉGEZ-VOUS
Le port des écouteurs ou d’un casque d’écoute pendant une période 
prolongée peut causer des troubles de l’ouïe sérieux.
Une exposition prolongée à un son plus élevé que 85 dB peut avoir un effet négatif 
sur votre ouïe. Plus le son est élevé, plus le problème de l’ouïe peut être sérieux 
(une conversation ordinaire s’élève entre 50 et 60 dB et le bruit de la route à environ 
80 dB). Nous vous recommandons fortement de régler le volume sur un niveau 
moyen (le niveau moyen se situe habituellement aux 2/3 du niveau maximum).
Si vous entendez un bourdonnement, baissez le volume ou cessez 
l’utilisation des écouteurs ou du casque.

PROTÉGEZ VOTRE LECTEUR MP3
Ne rangez pas l’appareil dans un lieu où la température excède 35° C 
(95° F) (comme dans un sauna ou une voiture en stationnement par 
exemple).
Évitez tout impact brutal sur l’appareil (ex. : en cas de chute).
Ne posez pas d’objets lourds sur le lecteur.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne placez pas le produit près d’un objet à propriétés magnétiques.
Veillez à toujours enregistrer vos données les plus importantes. 
Samsung dénie toute responsabilité pour les pertes de données.
Utilisez toujours les accessoires fournis ou agréés par Samsung.
Évitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil 
à l’aide de produits chimiques (ex. : benzène ou diluant) sous peine de 
provoquer un incendie, une décharge électrique ou une détérioration de 
la surface.
Suivez attentivement ces instructions sous peine de provoquer des 
dommages corporels ou d’endommager l’appareil.
Si vous souhaitez imprimer ce manuel, nous vous recommandons de 
l’imprimer en couleur et de cocher l’option d’imprimante “Ajuster à la 
page” pour une meilleure lecture.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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principes fondamentaux
ARTICLES COMPRIS
Votre nouveau lecteur MP3 vous parvient accompagné des accessoires 
suivants. Si certains de ces articles sont manquants, contactez le centre de 
service à la clientèle de Samsung.

Lecteur Écouteurs

Câble USB CD d’installation

L’aspect des accessoires est susceptible d’être amélioré et modifi é, sans 
notifi cation préalable. 
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VOTRE LECTEUR MP3

Affi chage à l’écran

Interrupteur Power (Alimentation) et 
Hold (Maintien)
Faites glisser le curseur dans le sens 
opposé à la fl èche et retenez-le pour 
allumer/éteindre l’appareil.
Déplacez-le dans la direction de la 
fl èche pour verrouiller les fonctions des 
touches.

Trou de la cordelette

Trou de réinitialisation
Si une défaillance se produit, 
appuyez sur le bouton de 
réinitialisation à l’aide d’un objet 
pointu pour réinitialiser le système.
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VOTRE LECTEUR MP3 (Suite)
Ce sont les ‘Touches’.

Touche de retour en arrière
Tapez sur la touche pour vous déplacer vers 

l’écran précédent. Appuyez longuement sur la 
touche

pendant un court moment pour vous 
déplacer vers le menu principal.

Touche d’augmentation du volume
Tapez sur la touche pour augmenter le 

volume sonore ou pour vous déplacer sur 
un élément/menu supérieur.

Touche Lecture/Pause et 
Sélectionner

Tapez sur la touche pour sélectionner 
lecture/pause et la fonction, ou pour vous 

déplacer vers l’écran suivant.

Flèche de gauche du navigateur de fi chiers
Tapez sur la touche pour sélectionner la piste ou 

le menu précédent ou pour lire la piste en cours à 
partir du début.

Appuyez longuement sur la touche pendant un 
court moment pour balayer rapidement les pistes.

Touche de diminution du volume
Tapez sur la touche pour diminuer le 

volume sonore ou pour vous déplacer sur 
un élément/menu inférieur.

Flèche de droite du navigateur de 
fi chiers

Tapez sur la touche pour vous déplacer sur 
la piste ou sur le menu suivant. Appuyez 

longuement sur la touche pendant un court 
moment pour balayer rapidement les pistes.

Touche Menu
Tapez pour affi cher le menu
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VOTRE LECTEUR MP3 (Suite)

Écouteurs
Ils sont marqués d’un “L” pour 

l’écouteur de gauche et d’un 
“R” pour l’écouteur de droite. Ils 

servent aussi d’antenne FM pour 
le lecteur MP3.

Prise de branchement des 
écouteurs

Port USB
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ÉCRANS D’AFFICHAGE
Musique

1 Témoin du menu parent

2
Verrouillage/témoin d’alarme/
témoin de minuteur de mise en 
veille

3 État de la pile

4 Piste présentement en lecture / 
témoin du nombre de pistes

5 Témoin de vitesse de lecture

6 L’heure actuelle

7 Durée totale de la lecture

8
Témoin du lecture/pause, 
recherche

9 Témoin du mode musique

10 Témoin du mode lecture

11 Témoin du mode DNSe

12 État de la lecture de musique

13 Titre de la musique

14 Barre d’état de la lecture

15 Durée actuelle de la lecture

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.REMARQUE

Music

  Rising Sun

02:13 04:28

15/20
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ÉCRANS D’AFFICHAGE (Suite)
Vidéo

1
Verrouillage/témoin 
d’alarme/témoin de minuteur 
de mise en veille 

6 Témoin du mode vidéo

2 État de la pile 7 Nom du fi chier

3 L’heure actuelle 8 Barre d’état de la lecture

4 Durée totale de la lecture 9 Durée actuelle de la lecture

5
Témoin de lecture/pause, 
recherche

Video Track 1

5

6

7

8

9

1

2

3

4
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ÉCRANS D’AFFICHAGE (Suite)
Photo

1
Verrouillage/témoin d’alarme/
témoin de minuteur de mise en 
veille

2 État de la pile

3 Témoin Fichier actuel / Nombre 
total de fi chiers

4 L’heure actuelle

5 État de la lecture de musique

6 Témoin du mode Photo

7 Témoin du menu parent

8 Nom du fi chier

Radio FM
1 L’heure actuelle

2 État de la pile

3
Verrouillage/témoin d’alarme/
témoin de minuteur de mise en 
veille

4 Témoin du mode Radio

5 Témoin manuel/préprogrammé

6 Témoin de la fréquence actuelle (MHz)

7
Témoin de localisation de la 
fréquence

[Écran de prévisualisation]
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UTILISATION DES TOUCHES
Tapez délicatement sur la touche tactile du bout du doigt.

Pour éviter d’endommager l’écran tactile, évitez d’utiliser un objet autre que vos 
doigts pour le manipuler.
Veillez à garder les mains propres lorsque vous souhaitez utiliser le pavé tactile.
Ne tapez pas l’écran tactile avec des gants.
Il peut mal fonctionner si vous utilisez vos ongles ou un autre objet comme un stylo 
à bille.

REMARQUE
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CHARGEMENT DE LA PILE
Chargez-la avant d’utiliser votre lecteur pour la première fois et lorsqu’il n’a pas 
été utilisé pour une période prolongée.
Charger la pile de votre lecteur MP3 prend environ 4 heures ; la durée totale du 
chargement peut varier en fonction des conditions de votre ordinateur.

1. Branchez la grande fi che du câble USB sur la prise du port USB située sur le 
dessous du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.

2

Affi chage à l’écran
USB connected 
(USB connecté.)

1
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ENTRETIEN DE LA PILE
Suivre ces simples conseils d’entretien et de rangement prolongera la durée de 
votre pile.
• Rechargez et rangez l’appareil dans un lieu où la température est comprise 

entre 5°C et 35°C. 
• Évitez de surcharger la batterie (12 heures au maximum). Charger ou 

décharger la batterie à des fréquences trop rapprochées peut réduire sa 
durée de vie.

• Comme pour tout autre produit de consommation, la durée de vie de la 
batterie raccourcit progressivement avec le temps.

Si vous chargez le lecteur pendant qu’il est branché sur un ordinateur portable, 
veillez à ce que la pile du portable soit aussi complètement chargée ou qu’il soit 
branché sur une source d’alimentation.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Faites glisser le commutateur dans le sens 
opposé à la fl èche et retenez-le.

L’appareil s’allume.

Mise hors tension de l’appareil
Faites glisser à nouveau le commutateur dans
le sens opposé à la fl èche et retenez-le.

Le lecteur s’éteint.

Votre lecteur MP3 s’éteindra automatiquement si aucune des touches n’est 
actionnée pendant une période spécifi que en mode pause. Le réglage à l’usine 
de la fonction <Auto Power Off> (Extinction auto) est de 1 minute ; vous pouvez 
cependant en modifi er la durée. Reportez-vous à la page 29 pour plus de détails.

REMARQUE

REMARQUE
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LECTURE DE PIÈCES MUSICALES
Téléchargez les fi chiers musicaux sur votre nouveau lecteur MP3 à l’aide de 
Samsung Media Studio. Pour en savoir plus à propos de Samsung Media 
Studio, reportez-vous aux pages 33~35.
1. Appuyez longuement sur [ ] pendant un court moment 

pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner 

<Music> (Musique), puis sur [ ].
3. Tapez sur les touches [Haut, Bas] et [ ] pour 

sélectionner le fi chier musical de votre choix.
4. Tapez sur [ ].

La lecture du fi chier musical est lancée.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

CONTRÔLE DU VOLUME
Tapez sur la touche [Haut, Bas].

L’icône du contrôle de volume s’affi che.
Le réglage de la dynamique se situe entre 0 et 30.
Tapez sur la touche [Haut] pour augmenter le volume et sur la 
touche [Bas] pour le diminuer.

REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Music

  Rising Sun

02:13 04:28

15/20
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DÉSACTIVATION DES TOUCHES
La fonction de verrouillage désactive toutes les autres touches du lecteur MP3. 
Ainsi, si vous en touchez une par accident pendant vos exercices par exemple, 
votre musique ne s’arrêtera pas.
1. Faites glisser le commutateur  dans le sens 

de la fl èche.
2. Faites glisser le commutateur  dans le sens 

opposé à celui indiqué par la fl èche pour désactiver la 
fonction Lock (Verrouillage).

NAVIGUER DANS LES FICHIERS À 
L’AIDE DU “DOSSIER NAVIGATEUR”
Recherchez des fi chiers en toute simplicité grâce la fonction “File Browser”
(Dossier Navigateur).
1. Appuyez longuement sur [ ] pendant un court moment 

pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner 

<File Browser> (Dossier Navigateur), puis sur [ ].
La liste de dossiers du <File Browser> (Dossier Navigateur) 
contenant “Music (Musique), Playlists (Listes de lecture), Videos 
(Vidéos), Pictures (Images), Datacasts (Dif. donn.), Texts (Textes) 
et Recorded Files (Fichiers Enregistrés)” s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
dossier souhaité.

4. Tapez sur [ ] pour affi cher la liste de fi chiers contenus dans le dossier.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.

5. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier souhaité.
6. Tapez sur [ ].

La lecture du fi chier débute.

Music

  Rising Sun

02:13 04:28

15/20
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SUPPRIMER DES FICHIERS À L’AIDE DU “DOSSIER 
NAVIGATEUR”
1. Appuyez longuement sur [ ] pendant un court moment 

pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner 

<File Browser> (Dossier Navigateur), puis sur [ ].
La liste de dossiers du <File Browser> (Dossier Navigateur) 
s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
dossier souhaité, puis sur [ ].

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier 
que vous souhaitez supprimer, puis sur [ ].

5. Tapez sur la touche [Haut, Bas] pour sélectionner <Delete> (Supprimer), puis 
sur [ ].

6. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), puis 
sur [ ].

Le fi chier est supprimé.

Les fi chiers ne peuvent pas être récupérés une fois supprimés.
ATTENTION

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Recorded Files
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Tapez sur [ ] pour vous déplacer vers l’écran précédent. 
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

Réglage du style de menu
Vous pouvez modifi er les polices et le modèle du menu et supprimer le 
fond d’image du menu principal.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner 

<Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner <Menu
Style> (Style du menu), puis sur [ ].

Le menu <Menu Style> (Style du menu) apparaît.
4. Les touches [Haut, Bas] et [ ] servent à régler des 

fonctions.
Tapez sur [ ] pour passer à l’élément/menu suivant.
Tapez sur la touche [Haut, Bas] pour vous déplacer vers le haut ou vers le bas dans 
le menu actuel.

Options de réglage du style de menu
Menu Design (Aspect du menu) : Pour modifi er le style d’écran du menu principal. 
Sélectionnez parmi <Sparkling> (Brillant), <Crystal> (Cristal) et <My Skin> (Mon habillage).
Font (Police) : Pour modifi er la police de la langue des menus. Sélectionnez parmi 3 
polices. Certaines langues des menus n’affi chent pas la fonction <Font> (Police).
Reset My Skin (Réinitialiser mon habillage) : Pour recomposer le fond d’image de l’écran 
tactile à sa valeur par défaut. Pour recomposer le fond d’image de l’écran tactile à sa valeur 
par défaut. Si vous défi nissez <Sparkling> (Brillant) ou <Crystal> (Cristal) sous <Menu 
Design> (Aspect du menu), <Reset My Skin> (Réinitialiser mon habillage) sera désactivé.

REMARQUE

Settings

Menu Style
Sound
Display
Language
Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du 
volume sonore.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour 

sélectionner <Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Sound> (Son), puis sur [ ].

Le menu <Sound> (Son) apparaît.

4. Les touches [Haut, Bas] et [ ] servent à régler 
des fonctions.

Options de réglage du son
Master EQ (EG princ.) : Pour optimiser les paramètres sonores.
Tapez sur la touche [Gauche, Droite] pour sélectionner la fréquence que vous 
souhaitez paramétrer. Tapez sur la touche [Haut, Bas] pour régler le niveau de la 
fréquence sélectionnée, puis sur [ ].
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission d’un 
signal sonore lors des opérations effectuées sur l’écran tactile. Choisissez entre 
<Off> (Arrêt) et <On> (Marche). 
Volume Limit (Limitation du Volume) : Permet d’éviter les problèmes de l’ouïe 
en réglant la limite du volume sonore lorsque vous utilisez les écouteurs. <On> 
(Marche) limite le volume sonore à un niveau maximum de15. Le niveau maximum 
du volume est de 30 lorsque la fonction de limite est sur <Off> (Arrêt). Afi n d’éviter 
les troubles de l’ouïe, le niveau du volume revient sur 15 lorsque vous rallumez le 
lecteur même si vous aviez désactivé la limite <Off> (Arrêt).

Settings

Menu Style
Sound
Display
Language
Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres de l’écran
Permet de modifi er la période avant l’extinction, l’économiseur d’écran 
et la luminosité de votre écran.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour 

sélectionner <Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Display> (Affi cher), puis sur [ ].

Le menu <Display> (Affi cher) apparaît.

4. Les touches [Haut, Bas] et [ ] servent à régler 
des fonctions.

Options de réglage de l’écran
Display Off (Affi ch. Désactivé) : Si aucune touche n’est activée durant les périodes 
indiquées plus bas, l’écran s’éteint automatiquement. Vous pouvez choisir entre 
<15sec>, <30sec>, <1min>, <3min>, <5min>, et <Always On> (Toujours allumé). 
Appuyez sur n’importe quelle touche pour rallumer l’écran.
Screen Saver (Économiseur d’écran) : Vous permet de sélectionner une image 
comme économiseur d’écran. Sélectionnez entre <Auto Change> (Chang. auto), 
<Sweet> (Doux), <Blue Rain> (Mélancolie), <Cheers> (Bravo), <Analog Clock> 
(Heure analogique), <Digital Clock> (Horloge numérique), puis réglez la période 
d’attente. Vous pouvez choisir entre <Off> (Arrêt), <15sec>, <30sec>, <1min>, 
<3min> et <5min>. Si aucune touche n’est activée durant les périodes indiquées 
plus haut, le lecteur affi che l’économiseur d’écran. Vous pouvez modifi er l’image de 
l’économiseur d’écran en tapant sur [ ] en cours d’operation.
Brightness (Luminosité) : Vous pouvez régler la luminosité de l’écran. Sélectionnez 
un niveau entre <0 et 10>, 10 étant le plus lumineux.

Settings

Menu Style
Sound
Display
Language
Time 
System
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Settings

Menu Style
Sound
Display
Language
Time 
System

MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres de la langue
Les menus de votre nouveau lecteur MP3 peuvent être réglés de façon 
à apparaître dans plusieurs langues. Il est très facile de changer la 
langue selon votre choix.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour 

sélectionner <Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner
<Language> (Langue), puis sur [ ].

Le menu <Language> (Langue) apparaît.
4. Les touches [Haut, Bas] et [ ] servent à régler 

des fonctions.
Options de réglage de la langue

Menu : Permet de régler la langue du menu. Choix disponible <English>, 
< >, <Français>, <Deutsch>, <Italiano>, < >, < >,
< >, <Español>, < >, <Magyar>, <Nederlands>, <Polski>, 
<Português>, <Svenska>, < >, < eština>, < >, <Türkçe>, <Norsk>, 
<Dansk>, <Suomi>, <Español (Sudamérica)>, <Português (Brasil)>, <Indonesia>, 
<Ti ng Vi t>, <Bulgarian>, <Român >, < >, <Slovenš ina> ou 
<Slovenský>.
Contents (Sommaire) : Pour défi nir la langue de l’information de la piste et du 
texte. Choix disponible <English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Simplifi ed Chinese>, <Tranditional Chinese>, <Spanish>, <Russian>, 
<Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, <Finnish>, 
<Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, 
<Estonian>, <Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, 
<Turkish> ou <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres de l’heure
L’heure vous permet d’utiliser les fonctions d’horodatage, du modèle de 
la date et même le fuseau horaire.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour 

sélectionner <Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Time> (Heure), puis sur [ ].

Le menu <Time> (Heure) apparaît.

4. Les touches [Haut, Bas] et [ ] servent à régler 
des fonctions.

Options de réglage de l’heure
Date&Time (Date et heure) : Cette fonction vous permet de régler l’heure et la date 
actuelles. Tapez sur la touche [Haut, Bas] pour accéder à <Year, Month, Date, Hour, 
Min, AM/PM> (An, Mois, Jour, Heure, Min, AM/PM) et tapez sur la touche [Haut, 
Bas] pour régler chaque élément.
Date Type (Type date) : Pour régler le modèle de la date d’affi chage de l’horloge 
universelle. Sélectionnez parmi : <YY-MM-DD> (AA-MM-JJ), <MM-DD-YY> (MM-JJ-
AA) et <DD-MM-YY> (JJ-MM-AA).
Time Zone (Fuseau hr) : Pour modifi er l’heure actuelle en sélectionnant le fuseau 
horaire d’une ville en particulier. Vous devez régler le fuseau horaire avant de 
pouvoir affi cher l’heure universelle. Reportez-vous à la 84.

Settings

Menu Style
Sound
Display
Language
Time
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres du système
Choisissez les réglages par défaut qui vous conviennent pour les 
fonctions alarme, mode de mise en marche et de mise hors tension 
automatique.
1. Appuyez longuement sur [ ] pendant un court 

moment pour vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour 

sélectionner <Settings> (Paramètres), puis sur [ ].
Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<System> (Système), puis sur [ ].

Le menu <System> (Système) apparaît.

4. Les touches [Haut, Bas] et [ ] servent à régler 
des fonctions.

Settings

Menu Style
Sound
Display
Language
Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Options de réglage du système

Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après l’écoulement 
de la durée présélectionnée. Choix disponibles : <Off> (Arrêt), <15min >, <30min>, 
<60min>, <90min> ou <120min>.
Start Mode (Mode Début) : Permet de choisir le mode à affi cher à l’allumage 
du lecteur. Sélectionnez parmi <Home> (Dom.) et <Last State> (Dernier Etat). 
Sélectionnez <Home> (Home) pour démarrer le système en affi chant le menu 
principal et <Last State> (Dernier Etat) pour affi cher le denier menu utilisé.
Auto Power Off (Extinction auto) : Permet d’éteindre automatiquement 
l’appareil lorsque aucune touche n’est actionnée avant l’écoulement de la durée 
présélectionnée en mode Pause. Sélectionnez parmi : <15sec>, <30sec>, <1min>, 
<3min>, <5min> et <Always On> (Toujours allumé).
Default Set (Réglages par défaut) : Permet de revenir aux valeurs de réglage par 
défaut. Options disponibles :  <Yes> (Oui) ou <No> (Non). <Yes> (Oui) permet 
d’initialiser tous les réglages par défaut.  <No> (Non) permet d’annuler les réglages 
par défaut.
Format (Formater) : Permet de formater la mémoire interne. Options disponibles 
:  <Yes> (Oui) ou <No> (Non). <Yes> (Oui) formate la mémoire interne et supprime 
tous les fi chiers du lecteur. <No> (Non) prévient le formatage de la mémoire interne. 
Vérifi ez avant de formater.
About (À propos de) : Vérifi e la version de micrologiciel et la capacité de la 
mémoire. <Firmware Version> (Version du fi rmware) affi che la version de 
micrologiciel courante. <Used> (Utilisé) indique l’usage, <Available> (Disponible) 
indique la capacité restante et <Total> indique la capacité totale de la mémoire.

À propos de la mémoire intégrée
1 Go = 1.000.000.000 d’octets : la capacité formatée réelle peut être 
inférieure puisque le micrologiciel utilise une partie de la mémoire.

REMARQUE
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RÉINITIALISER LE SYSTÈME
Ils sera possiblement nécessaire de réinitialiser le système s’il devient 
impossible d’allumer votre lecteur MP3, s’il ne lit pas la musique ou s’il n’est pas 
reconnu par votre ordinateur lorsque vous le branchez.

Appuyez sur la touche Reset situé sur la 
partie inférieure de l’appareil à l’aide d’un 
objet pointu, comme une un trombone.

Le système est réinitialisé.
Cela n’affecte pas vos réglages ou vos fi chiers.
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samsung media studio
Samsung Media Studio est une application logicielle conviviale qui 
vous aide à répartir les fi chiers de votre ordinateur. Après avoir trié et 
réparti vos fi chiers à l’aide de Media Studio, vous pouvez les transférer 
rapidement vers votre lecteur MP3 sans avoir à effectuer une recherche 
complète de votre disque dur pour trouver le bon fi chier.

BESOINS DE L’ORDINATEUR
Votre système d’ordinateur doit posséder les caractéristiques minimales qui 
suivent afi n de pouvoir installer et exécuter Media Studio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque dur
• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10,0 ou ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou ultérieur
• 512 Mo de mémoire vive ou plus
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INSTALLATION DE SAMSUNG MEDIA STUDIO
Veillez à exécuter le programme d’installation de <Media Studio> dans le compte 
administrateur de votre ordinateur. Autrement, il vous sera impossible d’installer 
<Media Studio>. Reportez-vous au mode d’emploi de votre ordinateur pour trouver 
le compte administrateur.

1. Insérez le CD d’installation fourni 
avec le lecteur dans le lecteur de 
CD-ROM de votre ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

Suivez les instructions pour lancer l’installation.

L’installation de <Media Studio> est lancée et crée l’icône  sur votre poste de travail 
à la fi n de l’installation.

Soyez prudent lorsque vous insérez le CD d’installation dans un lecteur CD-ROM à 
la verticale.

ATTENTION

ATTENTION
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO
<Media Studio> vous permet de sélectionner et de répartir vos fi chiers et dossiers 
en prévision d’un transfert vers votre lecteur. Cela facilite et accélère la recherche 
de fi chiers sur votre lecteur MP3. Le logiciel <Media Studio> est la méthode la plus 
facile d’effectuer un transfert de fi chier de votre ordinateur sur votre lecteur MP3.

1. Branchez la grande fi che du câble USB sur la prise du port USB située sur le 
dessous du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
<USB connected> (Connexion USB) apparaît à l’écran tactile du lecteur.
<Media Studio> démarre automatiquement lorsque vous branchez le lecteur sur votre 
ordinateur.
Si le programme ne démarre pas automatiquement, double-cliquez sur l’icône 
Media Studio du bureau.

La technologie de reconnaissance musicale et les données relatives sont fournies 
par Gracenote et Gracenote CDDB® Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo “Powered by Gracenote CDDB” 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote. 

1

2

REMARQUE
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO (Suite)
3. Cliquez sur l’icône du type de fi chier que 

vous souhaiter transférer.
Cliquez sur  pour affi cher la liste musicale.

Cliquez sur  pour affi cher la liste des fi chiers 
   vidéo.

Cliquez sur   pour affi cher la liste de photos.
Cliquez sur  pour affi cher la liste de etc. La 
liste ETC comprend les autres types de fi chier 
(ex. :  TXT, etc.) sauf les fi chiers musique, photo 
et vidéo.

4. Cliquez sur <Add File> (Ajouter un fi chier) au bas 
de l’écran de <Media Studio>.

La fenêtre <Open> (Ouvert) apparaît.

5. Sélectionnez les fi chiers que vous souhaitez 
ajouter et cliquez sur <Open> (Ouvrir).

Les fi chiers sélectionnés sont ajoutés sur la liste à 
gauche de l’écran de <Media Studio>.

6. Sélectionnez le fi chier à transférer sur la liste 
de gauche.

7. Cliquez sur l’icône .
Le fi chier sélectionné est transféré vers le lecteur.

YP-S3[MTP]

[YP-S3[MTP]] > M.3

4

7

6

 YP-S3[MTP]

[YP-S3[MTP]] > M.

5
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO (Suite)

Ne débranchez jamais le câble USB durant le transfert de fi chiers. Le débrancher 
durant le transfert peut endommager le lecteur ou votre ordinateur.
Pour éviter les connexions instables, branchez le lecteur directement sur votre 
ordinateur plutôt que par le biais d’un répéteur multiport USB.

Avant le transfert du fi chier vidéo vers le lecteur à l’aide de la fonction <Media 
Studio>, le fi chier est tout d’abord converti automatiquement au format .svi. 
La taille du fi chier est également réglée automatiquement. 
Lorsque vous transférez une photo sur le lecteur à l’aide de <Media Studio>, elle 
est automatiquement convertie au format JPG avant son transfert. La taille du 
fi chier est aussi ajustée.

Toutes les fonctions sont désactivées durant le branchement.

Si vous branchez le câble USB sur le lecteur alors que la pile est faible, le lecteur 
sera mis sous charge pendant plusieurs minutes avant d’établir sa connexion avec 
l’ordinateur.

Il est conseillé d’utiliser le système de fi chiers FAT 32 lors du formatage du lecteur 
sur votre ordinateur.

Samsung Media Studio comprend une fonction d’aide approfondie. Si vous ne 
pouvez trouver réponse à votre question à propos de Media Studio, cliquez sur 
<MENU> <Help> (Aide) <Help> (Aide) au haut du programme <Media 
Studio>.
Qu’est-ce que SVI ?
Samsung Audio Video interleaving (SVI) (Entrelacement audio-vidéo de Samsung) 
est un nouveau format vidéo développé et contrôlé par Samsung.

ATTENTION

REMARQUE
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Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music Music

  Rising Sun

02:13 04:28

15/20

écoute de la musique
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

ÉCOUTE PAR CATÉGORIE

1. Appuyez longuement sur [ ] pendant un court moment pour vous déplacer 
vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner <Music> (Musique), 
puis sur [ ].

Le menu <Music> (musique) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la liste souhaitée, puis sur 
[ ].

Le fi chier musical apparaît.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier à lire, puis sur [ ].
La lecture de la musique démarre.

REMARQUE
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ÉCOUTE PAR CATÉGORIE (Suite)

Liste de fi chiers musicaux
Les renseignements reliés au fi chier incluant le nom de l’artiste, le nom de l’album, le titre 
de la pièce musicale et son genre s’affi chent en fonction de l’étiquette ID3 du fi chier musical 
approprié. Un fi chier sans étiquette ID3 s’affi che comme [unknown] (inconnu).
Now Playing (En Lecture) : Lit un fi chier récemment lu ou se déplace sur l’écran de lecture du 

fi chier actuel.
Artists (Artiste) : Lecture par artiste
Albums (Albums) : Lecture par album
Songs (Chansons) : Lecture en ordre numérique ou alphabétique
Genres (Genres) : Lecture par genre
Playlists (Listes de lecture) : Lecture par liste
Recorded Files (Fichiers Enregistrés) : Affi che les fi chiers enregistrés.
Music Browser (Navig. musique) : Affi che tous les fi chiers musicaux stockés dans le dossier 

Musique.

Les fi chiers musicaux MP3 et WMA sont compatibles avec votre lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Si vous débranchez les écouteurs durant la lecture de musique, le lecteur passera 
en mode Pause.
Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives 
au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ 
commentaire.

REMARQUE
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PAUSE
1. Tapez sur [ ] en cours de lecture.

La lecture de la musique est interrompue.

2. Tapez encore sur [ ].
La lecture reprend à l’endroit où vous l’avez suspendue.

RECHERCHE SUR UNE PISTE
1. Appuyez longuement sur la touche [Gauche, Droite] pendant que la piste 

sélectionnée est en cours de lecture.
Ces touches permettent d’effectuer la recherche vers le début ou la fi n de la piste.

2. Relâchez la touche dès que vous souhaitez reprendre la lecture.
La lecture commence dès que vous relâchez la touche.

LECTURE DE LA PISTE EN COURS À PARTIR DU DÉBUT
1. Tapez sur la touche [Gauche] après 3 secondes de lecture.

La piste en cours est lue à partir du début.

POUR ÉCOUTER LA PISTE PRÉCÉDENTE
Tapez sur la touche [Gauche] dans les 3 premières secondes de lecture.
Tapez deux fois sur la touche [Gauche] après 3 secondes de lecture.

La lecture de la piste précédente démarre.

LECTURE DE LA PLAGE SUIVANTE
Tapez sur la touche [Droite].

La lecture de la piste suivante démarre.
Pendant la lecture de fi chiers VBR, la piste précédente peut ne pas être lue même si 
vous tapez sur la touche [Gauche] au cours des 3 premières secondes de lecture.ATTENTION
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG
<Media Studio> (Média Studio) vous permet de créer votre propre collection ou liste de 
lecture de fi chiers audio.

Avant de démarrer -  Branchez le lecteur sur l’ordinateur. Media Studio doit être 
installé sur l’ordinateur.

Comment créer une liste de lecture

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de 
<Media Studio> (Média Studio).

La fenêtre <Playlists> (Listes de lecture) apparaît.
2. Cliquez sur la touche <New Playlists> (Nouvelles listes de lecture) au 

bas de l’écran.
La fenêtre <Create Playlists> (Créer des listes de lecture) apparaît.

3. Tapez le titre de la liste de lecture et cliquez sur [OK].
Une nouvelle liste de lecture est créée et stockée dans la section <Playlists> 
(Listes de lecture) de <Media Studio> (Média Studio).

2

1
YP-S3[MTP]

OK 3

[YP-S3[MTP]] >
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG (Suite)  

Comment ajouter des fi chiers musicaux sur une liste de 
lecture que vous avez créée

1. Cliquez sur la touche <My PC> (Mon ordinateur) au haut de <Media
Studio> (Média Studio).

La fenêtre <My PC> (Mon ordinateur) apparaît.
2. Cliquez sur la touche <Playlists> (Listes de lecture) dans le coin droit 

de la fenêtre.
La fenêtre <Playlists> (Listes de lecture) apparaît.

3. Double-cliquez sur une liste de lecture dans la fenêtre de droite.s
4. Sélectionnez les fi chiers que vous souhaitez transférer dans la 

fenêtre <My PC> (Mon ordinateur). 
5. Cliquez sur l’icône .

Les fi chiers sélectionnés sont ajoutés sur la liste de lecture.

5

1

3

4 2

  YP-S3[MTP]
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG (Suite)

Exporter une liste de lecture vers votre lecteur à l’aide 
de Média Studio

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de <Media
Studio> (Média Studio).

La fenêtre <Playlists> (Listes de lecture) apparaît.
2. Sélectionnez une liste de lecture dans la section <Playlists> (Listes 

de lecture).
3. Cliquez sur l’icône .

La liste de lecture sélectionnée sera transférée vers le lecteur en passant 
par <File Browser> (Dossier Navigateur)  <Playlists> (Listes de lecture).

Le lecteur peut lire jusqu’à 999 fi chiers musicaux par liste de lecture.

1

32

YP-S3[MTP]

[YP-S3[MTP]] >

REMARQUE
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POUR CRÉER UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez 
créer une liste de lecture “favorite” sans avoir à utiliser Media Studio ou votre 
ordinateur.
1. Appuyez longuement sur [ ] pendant un court moment pour 

vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner <File

Browser> (Dossier Navigateur), puis sur [ ].
3. Tapez sur la touche [Haut, Bas] pour sélectionner <Music>

(Musique), puis sur [ ].
Le(s) fi chier(s) musical/musicaux s’affi che (nt).

4. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier à 
ajouter à la liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

5. Tapez sur la touche [Haut, Bas] pour sélectionner <Add to 
Playlist> (Aj. à liste lect.), puis sur [ ].

<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

6. Tapez sur la touche [Haut, Bas] pour sélectionner un numéro 
de liste de lecture pour ajouter le fi chier sélectionné, puis sur 
[ ].

Le fi chier sélectionné sera ajouté à liste de lecture.
Vous pouvez vérifi er la liste de lecture dans <Music> (Musique) 

 <Playlists> (Listes de lecture)  <Playlist 1> (List lect 1) à 
<Playlist 5> (List lect 5) du menu principal.

Vous pouvez ajouter jusqu’à 100 fi chiers musicaux dans chaque liste de lecture 
(<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5)).

Music

Life is cool
My love
Add to Playlist
Delete from Pla..
Delete

Music

Life is cool
My love

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez longuement sur [ ] pendant un court moment pour 

vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner

<Music> (Musique), puis sur [ ].
La liste <Music> <Musique> s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Playlists> (Listes de lecture), puis sur [ ].

La/Les liste(s) de lecture s’affi che(nt).

4. Tapez sur la touche [Haut, Bas] pour sélectionner la liste de 
lecture de votre choix, puis sur [ ].

Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée s’affi chent.
Si une liste de lecture n’est pas trouvée, le message <No File> 
(Aucun fi chier) s’affi che à l’écran.

5. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier 
musical à lire, puis sur [ ].

La lecture du fi chier musical débute.

Reportez-vous aux pages 39 et 41 pour savoir comment 
transférer la liste de lecture avec <Media Studio>.REMARQUE

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Playlists

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

1/5
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POUR SUPPRIMER UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez longuement sur [ ] pendant un court moment pour 

vous déplacer vers le menu principal.
2. Tapez sur la touche [Gauche, Droite] pour sélectionner 

<Music> (Musique), puis sur [ ].
La liste musicale apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Playlists> (Listes de lecture), puis sur [ ].

La/Les liste(s) de lecture apparaît(nt).
4. Tapez sur la touche [Haut, Bas] pour sélectionner la liste de 

lecture de votre choix, puis sur [ ].
Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée s’affi chent.

5. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier à supprimer de la 
liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.
6. Tapez sur la touche [Haut, Bas] pour sélectionner <Delete from Playlist>

(Suppr. de liste lect.), puis sur [ ].
Une fenêtre de confi rmation apparaît.

7. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), puis sur [ ].
Le fi chier sélectionné est supprimé de la liste de lecture.

POUR SUPPRIMER TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 4 ci-dessus.
5. Tapez sur [ ].

Le menu de la liste de lecture apparaît.
6. Tapez sur la touche [Haut, Bas] pour sélectionner <Delete

All from Playlist> (Suppr. tt de liste lect.), puis sur [ ].
Une fenêtre de confi rmation apparaît.

7. Tapez sur la touche [Gauche, Droite] pour sélectionner
<Yes> (Oui), puis sur [ ].

Tous les fi chiers sont supprimés de la liste de lecture.

Playlist 1

Life is cool
My love
Delete from Pla..
Delete All from Pla

Playlist 1

Life is cool
My love
Delete from Playlist
Delete All from ..
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POUR UTILISER LE MENU MUSIQUE
Le menu Musique vous permet d’organiser tous les aspects de l’écoute en 
cours de lecture – depuis la lecture en boucle de pistes et d’albums à la 
sélection du fond d’écran.

Pour régler les effets sonores
Pour profi ter d’un son plus clair.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Sound Effect> (Effets Sonores), puis sur [ ].

Le menu <Sound Effect> (Effets Sonores) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
l’effet sonore souhaité, puis sur [ ].

Options des effets sonores
Street Mode (Mode Rue) : Pour écouter de la musique plus nette en extérieur en 
fi ltrant certains bruits de la rue. Sélectionnez <Off> (Arrêt) ou <On> (Marche).
Clarity (Netteté) : Pour écouter une musique plus nette à qualité améliorée. 
Sélectionnez <0 à 2>.

Tapez sur [ ] pour quitter le menu.
REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval
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POUR UTILISER LE MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre de 
Musique.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<DNSe>, puis sur [ ].

Le menu <DNSe> apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
DNSe souhaité, puis sur [ ].

Sélectionnez parmi <Normal>, <Rock>, <Vocal> (Voix), 
<Bass Boost> (Ampli. Basses), <Classical> (Classique), 
<Studio>, <Concert Hall> (Salle Concert), et <User> (Utilisateur).
Sélectionner <EQ> (EG) vous permet de régler <3D & BASS> et <User> 
(Utilisateur).  Reportez-vous à la 47.

Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) est un 
effet sonore développé par Samsung pour les lecteurs MP3.  
Cette option offre différents réglages sonores visant à améliorer le type de 
musique que vous écoutez.

REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval
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Music

1.Life is cool

02:13 04:28

15/20

EQ
3D & BASS

Music

1.Life is cool

02:13 04:28

15/20

EQ
3D & BASS

POUR UTILISER LE MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe) (Suite)
<EQ> (EG)
Vous pouvez ajuster des fréquences particulières selon vos préférences.
1 Tapez sur la touche [Haut, Bas] dans le menu DNSe 

pour sélectionner <User> (Utilisateur), puis sur la touche 
[Droite].

2. Tapez sur la touche [Haut, Bas] pour sélectionner <EQ>
(EG), puis sur [ ].

L’écran de réglage de <EQ> (EG) apparaît.
3. Tapez sur la touche [Gauche, Droite] pour sélectionner 

la fréquence que vous souhaitez régler, puis sur la 
touche [Haut, Bas] pour régler le niveau de la fréquence 
sélectionnée.

Vous pouvez régler le niveau de la fréquence sélectionnée de <–10 ~ +10> (–10 à +10).
4. Tapez sur [ ].

Le réglage est terminé.

<3D&BASS>
Vous pouvez régler l’effet sonore 3D et l’amplifi cation des basses fréquences.
1. Tapez sur la touche [Haut, Bas] dans le menu DNSe 

pour sélectionner <User> (Utilisateur), puis sur la touche
[Droite].

2. Tapez sur la touche [Haut, Bas] pour sélectionner <3D
& BASS> (3D & GRAVES), puis sur [ ].

L’écran de réglage de <3D & BASS> (3D & GRAVES) 
apparaîts.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<3D> ou <Bass> (Graves), puis sur la touche [Haut,
Bas].

Vous pouvez sélectionner un niveau de 0 à 4 pour l’effet sonore <3D> et un niveau 
de 0 à 4 pour <Bass> (Graves).

4. Tapez sur [ ].
Le réglage est terminé.
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour régler le mode de lecture
Sélectionnez un mode de lecture tel que Répéter.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Play Mode> (Mode lecture), puis sur [ ].

Le menu <Play Mode> (Mode lecture) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
mode de lecture souhaité, puis sur [ ].

Options du mode de lecture
Normal : Lecture ponctuelle et dans l’ordre de toutes les pistes.
Repeat (Répéter) : Pour la lecture en boucle de tous les fi chiers inclus dans le 

dossier en cours.
Repeat One (Répéter 1X) : Répétition ponctuelle d’un fi chier.
Shuffl e (Aléatoire) : Lecture aléatoire des fi chiers.

Music

  Rising Sun

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner l’écran de lecture musicale
Faites le choix d’un fond d’écran parmi ceux disponibles ou choisissez votre 
propre image à affi cher lorsque vous écoutez de la musique.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Music Play Screen> (Écran Lect. mus.), puis sur 
[ ].

Le menu <Music Play Screen> (Ecran Lect mus.) 
apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
l’écran de lecture musicale souhaité, puis sur [ ].

Options de l’écran de lecture musicale
Type 1 ~ Type 3 (Type 1 à Type 3) : Pour sélectionner un écran de lecture musicale.
Album Info. (Info.album): Les renseignements comprenant le nom de l’artiste, 
l’album et son genre s’affi chent si l’information de l’étiquette ID3 est stockée sur le 
fi chier musical.
Album Art (Image CD) : L’image de la jaquette de l’album s’affi che si elle est 
comprise dans l’information de l’étiquette ID3 du fi chier musical. Les images de 
jaquette de taille moindre que 200 pixels (à l’horizontale) x 200 pixels (à la verticale) 
sont soutenues.
Auto Change (Chang. auto) : Bascule automatiquement entre <Type 1> et <Type 3> 
à chaque lecture de fi chier musical différent.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un 
champ commentaire. 

REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Screen
Add to Alarm
Play Speed
Skip Interval
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour ajouter un son d’alarme
Vous pouvez ajouter votre fi chier musical favori à la liste des sons d’alarme 
et il se fera entendre la prochaine fois que l’alarme se déclenchera. 
Reportez-vous à la page page 81 pour le réglage de l’alarme.
1. Sélectionnez un fi chier musical à ajouter aux sons 

d’alarme et tapez sur [ ].
Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Add to Alarm> (Ajouter à alarme), puis sur [ ].

Le fi chier musical sélectionné est ajouté sur la liste des 
sons d’alarme.
Un seul fi chier musical peut être ajouté aux sons d’alarme.

Pour régler la vitesse de lecture
Vous pouvez accélérer ou ralentir la vitesse de lecture de votre musique préférée.

1. Tapez sur [ ] tout en écoutant la musique.
Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Play Speed> (Vitesse de lecture), puis sur [ ].

Le menu <Play Speed> (Vitesse de lecture) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la 
vitesse de lecture souhaitée, puis sur [ ].

Choisissez entre <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normal)>, <X 1.1>, <X 1.2> et <X 1.3>.
Plus le nombre est élevé, plus la vitesse de lecture sera 
rapide.

La vitesse de lecture réglée peut varier de la vitesse réelle en fonction du fi chier.
REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval

Music
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Sound Effect
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Music Play Scre..
Add to Alarm
Play Speed
Skip Interval
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour régler le saut d’intervalle
Vous pouvez vous déplacer à marche avant rapide dans un fi chier à 
différents intervalles. Vous pouvez sauter une piste entière ou plusieurs 
secondes à la fois.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Skip Interval> (Saut Intervalle), puis sur [ ].

Le menu <Skip interval> (Saut Intervalle) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
l’intervalle de saut souhaité, puis sur [ ].

Choisissez entre <1 Song> (1 chanson), <5sec>, 
<10sec>, <30sec> et <1min>.

Si le fi chier a été enregistré à débit binaire variable, la longueur réelle du saut 
peut varier de celle que vous avez sélectionné.REMARQUE

Music

  Rising Sun

02:13 04:28
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Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval
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POUR UTILISER LE MENU MUSIQUE (Suite)
Réglage d’un signet
Lorsque vous aurez défi ni un signet, vous pourrez facilement cette position.
1. Pendant l’écoute musicale, tapez sur [ ] à la 

position souhaitée.
Le menu Musique s’affi che.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Bookmark> (Signet), puis sur [ ].

Le menu <Bookmark> (Signet) s’affi che.
3. Tapez sur la touche [Haut, Bas] pour sélectionner 

<Add Bookmark> (Ajouter signet), puis sur [ ].
La position lecture / arrêt actuelle sera ajoutée au signet.
Le symbole [ | ] s’affi che sur la barre d’état.

Si vous avez déjà mis un signet, la fenêtre “Écraser” apparaît. Si vous sélectionnez 
<Yes> (Oui), le signet déjà mis est supprimé et un nouveau signet mis en place.
Un seul signet peut être défi ni par fi chier musical et vous pouvez défi nir un 
maximum de 50 signets.

Pour vous déplacer sur (lecture) / supprimer le signet
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.
2. Tapez sur la touche [Haut, Bas] pour sélectionner 

<Bookmark> (Signet), puis sur [ ].
Le menu <Bookmark> (Signet) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Go to Bookmark> (Accéd. à Signet) ou <Delete
Bookmark> (Supprimer signet), puis sur [ ].

Si vous sélectionnez <Go to Bookmark> (Accéd. 
à Signet), vous vous déplacerez jusqu’au signet 
sélectionné et la lecture débutera.
<Delete Bookmark> (Supprimer signet) enlève le signet sélectionné du fi chier 
musical.

REMARQUE

Music

  Rising Sun

02:13 04:28
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Delete Bookmark

Music
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pour visionner une vidéo
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez le 
bloc-piles. Transférez un fi chier vidéo au lecteur. Reportez-vous à la page 33~35
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<Videos> (Vidéos), puis sur [ ].

La liste des vidéos apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner une 
vidéo à lire, puis sur [ ].

Le fi chier vidéo sélectionné commence à défi ler à l’horizontale.

PAUSE
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le lecteur fait une pause.

2. Tapez encore sur [ ].
Le lecteur reprend le visionnement à partir 
du dernier point de pause.

Avant le transfert du fi chier vidéo vers le lecteur à l’aide de la fonction <Media 
Studio>, le fi chier est tout d’abord converti automatiquement au format .svi. 
La taille du fi chier est également réglée automatiquement.

REMARQUE

REMARQUE

Touche [Haut, Bas]

Touche [Gauche, Droite]

<En affi chage horizontal>
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POUR VOUS DÉPLACER SUR UNE IMAGE SPÉCIFIQUE
1. En affi chage horizontal, appuyez longuement sur la 

touche [Gauche, Droite].
Ceci vous permet de vous déplacer vers l’avant ou vers 
l’arrière dans le fi chier vidéo.

2. Relâchez la touche lorsque vous aurez atteint la 
position souhaitée.

La lecture de la vidéo démarre à partir de cette position.

POUR VISIONNER LE FICHIER VIDÉO PRÉCÉDENT
Tapez sur la touche [Gauche] dans les 3 secondes 
suivant le démarrage de la lecture du fi chier en cours.
Tapez deux fois sur la touche [Gauche] 3 secondes 
après le démarrage de la lecture du fi chier en cours.

Vous revenez sur la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
Tapez sur la touche [Droite].

Vous passez sur la vidéo suivante. Video Track 2

Video Track 1

Video Track 1
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Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

POUR UTILISER LE MENU VIDÉO
Réglage d’un signet
Lorsque vous aurez défi ni un signet, vous pourrez facilement cette position.
1. Tapez sur [ ] à la scène souhaitée en cours 

de visionnement.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Add Bookmark> (Ajouter 
signet), puis sur [ ].

La position lecture / arrêt actuelle sera ajoutée 
au signet.
Le symbole [ | ] s’affi che sur la barre d’état.

Si vous avez déjà mis un signet, la fenêtre « Écraser » apparaît. Si vous 
sélectionnez <Yes> (Oui), le signet déjà mis est supprimé et un nouveau signet 
mis en place.
Un seul signet peut être défi ni par fi chier vidéo et vous pouvez défi nir un 
maximum de 50 signets.

Pour vous déplacer sur (lecture) / supprimer le signet
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Go to Bookmark> (Accéd. à 
Signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur [ ].

Si vous sélectionnez <Go to Bookmark> (Accéd. à Signet), vous vous 
déplacerez jusqu’au signet sélectionné et la lecture débutera.
<Delete Bookmark> (Supprimer signet) enlève le signet sélectionné du fi chier 
vidéo.

Tapez sur [ ] pour quitter le menu.

REMARQUE

REMARQUE
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Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

POUR UTILISER LE MENU VIDÉO (Suite)
Pour régler l’engin Digital Natural Sound engine 
(DNSe) (Engin de son numérique naturel)
Pour sélectionner le son parfait pour tout genre de vidéo.
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <DNSe>, puis sur [ ].

Le menu <DNSe> apparaît.
3. Tapez sur la touche [Haut, Bas] pour 

sélectionner le DNSe souhaité, puis sur [ ].
Choisissez entre <Normal>, <Drama>(Drame) et <Action>.

Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) est un 
effet sonore développé par Samsung pour les lecteurs MP3. L’engin vous offre 
différentes qualités de son pour améliorer le genre de musique que vous écoutez.

Pour régler la luminosité
Vous pouvez régler la luminosité de l’écran.
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour
sélectionner <Brightness> (Luminosité), 
puis sur [ ].

Le menu <Brightness> (Luminosité) apparaît.
3. Tapez sur la touche [Haut, Bas] pour régler la luminosité souhaitée, 

puis sur [ ].
Choisissez entre <0~10>.

REMARQUE
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pour visionner des photos
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<Pictures> (Images), puis sur [ ].

La fenêtre de prévisualisation apparaît.
3. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner la photo que vous souhaitez affi cher, puis sur [ ].
La photo sélectionnée s’affi che.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.

Pour vous déplacer sur 
la photo précédente/suivante
En affi chage horizontal, tapez sur 
la touche [Gauche, Droite].

La photo précédente/suivante s’affi che.

Un fi chier JPG contenant les données 
incorrectes d’une vignette s’affi che dans .
Certaines photos peuvent être lentes à s’affi cher.
Lorsque vous transférez une photo sur le lecteur à l’aide de <Media Studio>, elle est 
automatiquement convertie au format JPG avant son transfert. La taille du fi chier est 
aussi ajustée.
Le <File Browser> (Dossier Navigateur) est aussi utile pour rechercher une photo. 
Reportez-vous à la page 21.

REMARQUE

REMARQUE

Touche [Haut, Bas]

Touche [Gauche, Droite]

<En affi chage horizontal>
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POUR UTILISER LE MENU PHOTO
Pour écouter la musique en regardant vos images
Vous permet d’écouter la dernière chanson lue tout en regardant une image.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Music> (Musique), puis sur [ ].

Le menu <Music> (Musique) apparaît.

3. Tapez sur la touche [Haut, Bas] pour 
sélectionner le mode souhaité, puis sur [ ].

<Off> (Arrêt) : Aucune musique d’atmosphère en regardant une image.
<On> (Marche) : Vous permet d’écouter la dernière pièce musicale lue tout en 
regardant une image.

Pour visualiser un diaporama
Comment procéder 1
1. Tapez sur [ ] en regardant une image.

L’icône [ ] s’affi chera à l’écran et le lecteur lancera le 
diaporama.

Comment procéder 2
1. En mode prévisionnement d’images, tapez sur [ ].

La fenêtre <Start Slideshow> (Démarrer diaporama) 
s’affi che.  

2. Tapez sur [ ].
 L’icône [ ] s’affi chera à l’écran et le lecteur lancera le 
diaporama.

Tapez sur [ ] pour quitter le menu.
REMARQUE

Pictures 1/8

Picture Image 1

Start Slideshow

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Stop Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

POUR UTILISER LE MENU PHOTO (Suite)
Arrêt du diaporama

Comment procéder 1
1. En mode diaporama, tapez sur [ ].

Le diaporama s’arrête.

Comment procéder 2
1. En mode diaporama, tapez sur [ ].

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Stop Slideshow> (Arrêt diaporama), puis sur [ ].

Le diaporama s’arrête.

Pour régler la vitesse du diaporama
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Slideshow Speed> (Vitesse 
diaporama), puis sur [ ].

Le menu <Slideshow Speed> (Vitesse 
diaporama) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la vitesse souhaitée, 
puis sur [ ].

Sélectionnez parmi : <Fast> (Rapide), <Normal> et <Slow> (Lent).
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POUR UTILISER LE MENU PHOTO (Suite)
Pour agrandir une photo
Vous pouvez zoumer une photo.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Zoom>, puis sur [ ].

Le menu <Zoom> apparaît.

3. Tapez sur la touche [Haut, Bas] pour 
sélectionner le niveau de zoom souhaité, 
puis sur [ ].

Choisissez entre <100%>, <200%> et <400%>.

4. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour accéder à la 
partie de la photo que vous souhaitez agrandir.

Pour annuler le zoom

Tapez sur [ ] à l’intérieur d’une image grossie.
La taille initiale revient.

Une grande photo peut prendre beaucoup de temps à s’agrandir.
REMARQUE

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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POUR UTILISER LE MENU PHOTO (Suite)
Pour faire pivoter l’image
Vous pouvez tourner une image, à votre gré.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Rotate> (Pivoter), puis sur [ ].

Le menu <Rotate> (Pivoter) apparaît.

3. Tapez sur la touche [Haut, Bas] pour 
sélectionner l’angle souhaité, puis sur [ ].

Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.

Pour sélectionner une photo comme fond d’écran
Vous pouvez utiliser une photo de votre choix comme fond d’écran.
1. Sélectionnez un fi chier photo à utiliser 

comme fond d’écran, puis tapez sur [ ].
Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Select as My Skin> (Sél.
comme habillage), puis sur [ ].

La fenêtre de confi rmation apparaît.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), 
puis sur [ ].

La photo sélectionnée est établie comme fond d’écran.
Si <My Skin> (Mon habillage) est sélectionné sous <Settings> (Paramètres) 
<Menu Style> (Style du menu)  <Menu Design> (Aspect du menu), l’image 
défi nie s’affi chera.

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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écoute de la radio FM
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<FM Radio> (Radio FM), puis sur [ ].

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (MUET)
1. Tapez sur [ ] tout en écoutant la radio FM.

Le son est désactivé.
2. Tapez sur [ ] une fois pour reprendre l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez 
des fréquences.
Les écouteurs sont utilisés comme antennes de réception des ondes FM.
Il se peut que le lecteur ne trouve pas de fréquences FM disponibles dans les 
régions où la réception est mauvaise.

REMARQUE

REMARQUE
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RECHERCHE DE STATIONS FM
1. Appuyez longuement sur la touche [Gauche, Droite] et relâchez en mode 

Manuel.
La recherche s’arrête sur la fréquence la plus près du point où la 
touche est relâchée.

OU,

1. Tapez sur la touche [Gauche, Droite] pour rechercher les 
fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression du touche.

Searching
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POUR UTILISER LE MENU RADIO FM
Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.
1. Tapez sur [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Go to Preset Mode> (Aller au 
mode pré-progr.), puis sur [ ].

<Preset> apparaît.

Si aucune fréquence de présélection n’est défi nie, le 
lecteur ne passe pas en mode Présélection.

Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche 
manuelle d’une fréquence à la fois sur la bande FM.
1. Tapez sur [ ] en Mode Présélection.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner <Go to 
Manual Mode> (Aller au mode manuel), puis sur [ ].

<Manual> apparaît.

REMARQUE

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

POUR UTILISER LE MENU RADIO FM (Suite)
Programmation de stations sur la mémoire
Vous pouvez stocker jusqu’à 30 stations sur la mémoire du lecteur 
MP3 et y retourner simplement en appuyant sur un numéro. Laissez 
le lecteur MP3 choisir uniquement les stations que vous voulez 
en mode manuel ou trouvez et stockez toutes les stations locales 
automatiquement.
Manuel – choisissez uniquement les stations que vous voulez 
stocker
1. Tapez sur la touche [Gauche, Droite] pour

sélectionner une fréquence à prérégler en mode 
manuel, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Add to Preset> (Ajouter aux 
présél.), puis sur [ ].

La fréquence sélectionnée s’ajoute sur la Liste 
présélection.

3. Pour défi nir d’autres fréquences présélectionnées, suivez les étapes 1 à 
2 ci-dessus.

Si la même fréquence est déjà défi nie, le réglage est désactivé.
REMARQUE
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POUR UTILISER LE MENU RADIO FM (Suite)
Programmation de stations sur la mémoire (Suite)
Automatique – pour enregistrer automatiquement toutes les 
stations reçues par le lecteur
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour
sélectionner <Auto Preset> (Présélection auto), 
puis sur [ ].

La fenêtre de confi rmation apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis sur [ ].

Vous pouvez programmer automatiquement jusqu’à 
30 sélections.

Annulation de la programmation automatique
Si vous souhaitez annuler la programmation automatique, tapez sur 
[ ] durant le processus.

La programmation automatique est annulée et seules les fréquences 
programmées à ce point sont enregistrées.

Si vous souhaitez écouter votre lecteur MP3 dans une autre ville, il sera 
probablement nécessaire de reprogrammer vos stations. 
Répétez simplement le processus pour supprimer les stations 
programmées et en programmer de nouvelles.

REMARQUE

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

POUR UTILISER LE MENU RADIO FM (Suite)

Écoute des stations programmées
En mode Présélection, Tapez sur la touche 
[Gauche, Droite] pour faire défi ler les chaînes 
présélectionnées.

Vous pouvez alors écouter la fréquence radio attribuée à 
ce numéro.

Suppression d’une station programmée
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. En mode Présélection, tapez sur la touche

[Gauche, Droite] pour rechercher une fréquence 
présélectionnée à supprimer, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Delete from Preset> (Suppr. du 
prérégl.), puis sur [ ].

La fréquence sélectionnée est supprimée.

3. Pour supprimer des fréquences présélectionnées, 
suivez les étapes 1 et 2 ci-dessus.
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Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

POUR UTILISER LE MENU RADIO FM (Suite)
Pour enregistrer une émission de Radio FM 
Vous pouvez enregistrer une émission de radio FM en tout temps 
pendant l’écoute de la radio. 
1. Tapez sur la touche [Gauche, Droite] pour

sélectionner une fréquence à enregistrer en 
mode Radio FM, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.
2. Tapez sur la touche [Haut, Bas] pour

sélectionner <Start Recording> (Démarrer enreg.),
puis sur [ ].

Un nom de fi chier créé automatiquement s’affi che et 
l’enregistrement commence.

Arrêter un enregistrement
1. Durant l’enregistrement, tapez sur [ ].

Un message s’affi che vous demandant si vous voulez 
écouter la lecture du fi chier récemment enregistré.

2. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui) ou <No> (Non), puis 
sur [ ].

<Yes> (Oui) – le fi chier enregistré est lu.
<No> (Non) – le fi chier enregistré n’est pas lu.
Le fi chier enregistré est stocké dans <File Browser> 
(Dossier Navigateur) <Recorded Files> (Fichiers 
Enregistrés) <FM Radio> (Radio FM).

Vous pouvez stocker un maximum de 999 fi chiers d’enregistrement de radio FM.
Vous pouvez effectuer jusqu’à 30 heures d’enregistrement environ (à 128 
kbit/s, 2 Go)
Le nom du fi chier d’enregistrement sera spécifi é automatiquement, par 
exemple, « FM_XXX.mp3 ».  « FM » indique un enregistrement de radio FM et 
« XXX » désigne le numéro du fi chier d’enregistrement. 

REMARQUE
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POUR UTILISER LE MENU RADIO FM (Suite)
Défi nir la qualité de l’enregistrement FM
Vous pouvez choisir la qualité de l’enregistrement radio FM.
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.
2. Tapez sur la touche [Haut, Bas] pour sélectionner 

<FM REC Quality> (Qualité ENR FM), puis sur [ ].
Le menu <FM REC Quality> (Qualité ENR FM) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
niveau de qualité souhaité, puis sur [ ].

Sélectionnez <Super High(192kbps)> (Très élevée 
(192 kbit/s)), <High(160kbps)> (Haut (160 kbit/s)) ou 
<Normal(128kbps)> (Normal (128 kbit/s)).
Plus le nombre est élevé, meilleure sera la qualité audio et 
plus la taille du fi chier sera grande.

Pour régler la Sensibilité FM
Permet la réception de plus ou moins de fréquences radio FM. Réglez 
la fonction <FM Sensitivity> (Sensibilité FM).
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.
2. Tapez sur la touche [Haut, Bas] pour sélectionner 

<FM Sensitivity> (Sensibilité FM), puis sur [ ].
Le menu <FM Sensitivity> (Sensibilité FM) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
niveau de recherche souhaité, puis sur [ ].

Sélectionnez entre <High> (Haut), <Middle> (Milieu) et 
<Low> (Bas).
Sélectionner <High> (Haut) augmente le nombre de 
fréquences reçues.

Tapez sur [ ] pour quitter le menu.
REMARQUE

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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POUR UTILISER LE MENU RADIO FM (Suite)
Réglage de la Région Radio
Vous pouvez modifi er les réglages de région FM avant d’aller à 
l’étranger.
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner
<FM Region> (Région Radio), puis sur [ ].

Le menu <FM Region> (Région Radio) apparaît.

3. Tapez sur la touche [Haut, Bas] pour 
sélectionner la fréquence FM présente dans votre 
région et tapez sur [ ].

Sélectionnez entre <Korea/US> (Corée/USA), 
<Japan> (Japon) ou <Other Countries> (Autres Pays).

Si vous modifi ez la fonction <FM Region> (Région Radio) de votre lecteur, 
les fréquences radio préprogrammées sont supprimées.
La région FM peut être supprimée ou modifi ée en fonction de la région 
cible du lecteur.
Bande de fréquences par région
- Korea/US (Corée/États-Unis) : Recherchez des fréquences FM comprises 
  entre 87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0 MHz 
  et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres Pays) : Recherchez des fréquences FM 

comprises entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

REMARQUE

Go to Manual M..
Delete from Pre..
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POUR UTILISER LE MENU RADIO FM (Suite)

Pour ajouter un son d’alarme
Vous pouvez ajouter votre poste radio FM préféré à la liste des 
mélodies d’alarme afi n de pouvoir l’entendre la prochaine fois que 
l’alarme se déclenchera. Reportez-vous à la page page 81 pour le 
réglage de l’alarme.
1. Sélectionnez une fréquence radio à ajouter aux 

sons d’alarme et tapez sur [ ].
Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Add to Alarm> (Ajouter à alarme), 
puis sur [ ].

Si vous réglez le son d’alarme à <FM Radio> (Radio 
FM) dans le paramètre alarme, vous pouvez écoutez 
la radio FM.

Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
Add to Alarm
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pour utiliser la diffusion de données
<Media Studio> vous permet le transfert des données de blogue et des fi chiers 
enregistrés au format RSS sur le lecteur pour votre plaisir.

Qu’est-ce que RSS ?
RSS représente Rich Site Summary (Résumé d’un site riche) ou Really Simple Syndication 
(Syndication réellement simple). Il s’agit d’un système de transmission de données au format 
XML utilisé pour transmettre de l’information sur les sites Web fréquemment mis à jour (les 
sites de nouvelles ou les blogues) de façon plus conviviale et facile.
Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement des informations mises-à- jour sans avoir à 
accéder à des sites de nouvelles, de blogue ou UCC fréquemment visités à chaque fois.
Avant de débuter -  Media Studio doit être installé sur votre ordinateur. 

Reportez-vous à la page 32.

POUR ENREGISTRER UNE CHAÎNE
Vous pouvez créer une nouvelle chaîne en vous enregistrant sur un site Web 
ou des pages Web pouvant accueillir le format RSS.
1. Cliquez sur <Subscribe> (S’abonner) en 

dessous de <Datacasts> (Diffusion de 
données) dans <Media Studio> (Média 
Studio).

2. Saisissez une adresse dans <URL> et 
cliquez sur < Next> ( Suivant).

Lorsque vous copiez une adresse Web et cliquez 
sur <Subscribe> (S’abonner), l’adresse copiée 
s’affi che automatiquement dans <URL>.
La fenêtre de confi rmation apparaît si l’adresse Web peut accueillir le format RSS.

3. Cliquez sur <OK>.
La chaîne souhaitée est enregistrée.
L’icône apparaît dans Diffusion de données pour l’enregistrement de la chaîne.

Reportez-vous à <Datacasts> (Diff. de donn.) de <Media Studio> pour obtenir des 
instructions détaillées.

REMARQUE

REMARQUE

2
2
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POUR CRÉER UNE NOUVEAU GROUPE DE CHAÎNES
Vous pouvez créer un nouveau groupe de gestion des chaînes par catégorie.
1. Cliquez sur <New Group> (Nouveau groupe) 

en dessous de <Datacasts> (Diffusion de 
données) dans <Media Studio> (Média Studio).

2. Tapez le nom de groupe et sa description, puis 
cliquez sur <OK>.

POUR TRANSFÉRER UNE 
DIFFUSION DE DONNÉES DE <MEDIA STUDIO>

Avant de débuter – Raccordez le lecteur à votre ordinateur.
Media Studio doit être installé sur votre ordinateur. Reportez-vous à la page 32.

1. <Media Studio> (Média Studio) est lancé 
automatiquement dès que le lecteur est 
raccordé à votre ordinateur.

Si le programme n’est pas lancé automatiquement, 
double-cliquez sur l’icône  de <Media Studio> 
(Média Studio) sur votre bureau.

2. Cliquez sur <Datacasts> (Diffusion de 
données) dans le haut de <Media Studio>
(Média Studio).

La liste de chaînes du groupe Diffusion de données 
apparaît.

3. Cliquez sur le groupe de chaînes souhaité.
4. Cliquez sur la chaînes souhaitée.
5. Sélectionnez l’article de forum que vous souhaitez transférer.
6. Cliquez sur l’icône .

L’article de forum de la chaîne sélectionnée est transféré sur le lecteur dans <File Browser> (Dossier 
Navigateur)  <Datacasts> (Diffusions).

Cliquez sur dans le haut de <Media Studio> pour vous déplacer sur l’écran précédent.
Dans <Datacasts> (Diffusion de données) de <Media Studio> (Média Studio), si l’article possède 
une pièce jointe, vous pouvez télécharger la pièce jointe sur le lecteur. Cependant, en raison des 
politiques du site Web concerné, il peut s’avérer impossible de télécharger la pièce jointe.

REMARQUE
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6
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VISUALISATION DES DIFFUSIONS DE DONNÉES
Vous pouvez visualisez les articles de forum des chaînes ajoutées à <Datacasts>
(Dif. donn.).

Avant de démarrer - Transférez sur le lecteur l’article de forum venant d’une chaîne 
avec <Media Studio> (Média Studio). Reportez-vous à la page 73.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<Datacasts> (Dif. donn.), puis sur [ ].

La liste des diffusions de données apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la liste 
des chaînes souhaitée, puis sur [ ].

Le titre est le même que celui de la chaîne ajoutée à 
<Datacasts> (Dif. donn.) de <Media Studio> (Média Studio).

4. Tapez sur la touche [Haut, Bas] pour sélectionner le titre 
de l’élément souhaité, puis sur [ ].

La liste des fi chiers apparaît.

L’icône  : Texte principal de l’article transféré
L’icône : Fichier photo
L’icône  : Fichier musical
L’icône : Fichier vidéo

5. Tapez sur la touche [Haut, Bas] pour sélectionner le 
fi chier souhaité, puis sur [ ].

La lecture du fi chier débute.

REMARQUE

Datacast 1
Datacast 2
Datacast 3
Datacast 4

Datacasts 1/4
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pour profi ter de l’offre prime pack
L’offre groupée Prime Pack vous permet d’utiliser différentes fonctions : lecture de 
texte, jeux, réglage de l’alarme, etc.

LECTURE DE TEXTE
Qu’il s’agisse d’un roman, du manuscrit d’une nouvelle histoire ou de votre article de 
recherche, le lecteur MP3 vous laisse le lire… tout en écoutant de la musique !

Avant de démarrer - Allumez le lecteur et vérifi ez l’état de la batterie. Transférez les fi chiers 
texte sur le lecteur à l’aide de <Media Studio>. Reportez-vous à la page 33.
Défi nissez la langue préférée pour les textes dans <Settings> (Paramètres)  <Language> 
(Langue)  <Contents> (Sommaire). Reportez-vous à la page 26.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
l’offre groupée <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) apparaît.
3. Tapez sur la touche [Haut, Bas] pour sélectionner <Text>

(Texte), puis sur [ ].
La liste des fi chiers texte apparaît.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier 
texte souhaité, puis sur [ ].

Le texte s’affi che à l’écran.

Pour vous déplacer sur la page précédente/suivante
Tapez sur la touche [Gauche, Droite].

Appuyez longuement sur la touche [Gauche, Droite] pour accéder de manière continue 
à la page précédente/suivante.

Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) 
pour rechercher un fi chier texte. Reportez-vous à la page 21.
Votre lecteur MP3 peut accueillir le format de fi chiers TXT en mode Texte.

REMARQUE

REMARQUE

Prime Pack

Text
Games
Alarm
World Clock
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POUR UTILISER LE MENU TEXTE
Pour écouter la musique en lisant du texte
Vous permet d’écouter la dernière pièce musicale lue tout en lisant du texte.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.
2. Tapez sur la touche [Haut, Bas] pour 

sélectionner <Music> (Musique), puis sur [ ].
Le menu <Music> (Musique) apparaît.

3. Tapez sur la touche [Haut, Bas] pour 
sélectionner le mode souhaité, puis sur [ ].

<Off> (Arrêt) :  Aucune musique d’atmosphère pendant 
la lecture du texte.

<On> (Marche) : Vous permet d’écouter la dernière pièce musicale lue tout 
en lisant du texte.

Pour revenir à la première page
Procédure à suivre pour lire un texte à partir de la première page.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.s
2. Tapez sur la touche [Haut, Bas] pour

sélectionner <Go to 1st Page> (Aller à la 1ère 
page), puis sur [ ].

La fenêtre de confi rmation pour revenir à la première 
page s’affi che.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis surs [ ].

Se déplace à la première page.

Tapez sur [ ] pour quitter le menu.
REMARQUE
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POUR UTILISER LE MENU TEXTE (Suite)
Pour instaurer un signet
Mettez un signet pour revenir sur ce point dans le texte en tout temps.
1. Tapez sur [ ] à la page souhaitée pendant la 

lecture de textes.
Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Add Bookmark> (Ajouter signet), 
puis sur [ ].

L’écran texte actuel possède un signet et le symbole 
[ ] s’affi che dans le coin gauche du haut.

Si vous avez déjà mis un signet, la fenêtre “Écraser” 
apparaît. Si vous sélectionnez <Yes> (Oui), le signet 
déjà mis est supprimé et un nouveau signet mis en place.
Un seul signet peut être mis par fi chier texte et vous pouvez mettre un 
maximum de 50 signets.

Accéder à (lire)/Supprimer un signet
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Go to Bookmark> (Accéd. à 
Signet) ou <Delete Bookmark> (Supprimer 
signet)s, puis sur [ ].

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).

REMARQUE
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Book1
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POUR UTILISER LE MENU TEXTE (Suite)
Pour modifi er la taille de police
Vous pouvez modifi er la taille de la police du texte.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Font Size> (Taille police), puis sur [ ].

La fenêtre du menu <Font Size> (Taille police) 
apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner la taille de police souhaitée, puis sur [ ].

Sélectionnez parmi : <Small> (Petit), <Medium> 
(Moyen) et <Large>.

Réglage de la couleur de la visionneuse de texte
Choisissez votre couleur préférée pour affi cher le texte.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour
sélectionner <Text Viewer Color> (Coul. 
visionn. text), puis sur [ ].

La fenêtre du menu <Text Viewer Color> (Coul. 
visionn. text) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner la couleur de la visionneuse de 
texte souhaitée, puis sur [ ].

Sélectionnez entre <Type 1> jusqu’à <Type 6>.
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JEUX VIDÉO
Votre lecteur mp3 inclut déjà des jeux palpitants! 

Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pendant un court moment pour vous déplacer vers le 
menu principal.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
l’offre groupée <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) apparaît.
3. Tapez sur la touche [Haut, Bas] pour sélectionner 

<Games> (Jeux), puis sur [ ].
La liste <Games> (Jeux) s’affi che.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le jeu 
souhaité, puis sur [ ].

Baseball
Mesurez vos prouesses à celles des meilleurs 
lanceurs de la ligue dans cette version du jeu 
préféré de l’Amérique.
Tapez sur la touche [Haut, Bas, Gauche, Droite]
pour sélectionner un menu ou une fonction.
Tapez sur [ ] pour lancer ou frapper la balle. 

Pizza Delivery
Seriez-vous en mesure de livrer la pizza à temps 
et éviter les multiples obstacles sur votre chemin.
Tapez sur [ ] pour sauter.

REMARQUE

Prime Pack

Text
Games
Alarm
World Clock
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JEUX VIDÉO (Suite)
Honeybee
Jeu de casse-tête dans lequel vous devez placer plus 
de 3 morceaux pour augmenter vos points.
Utilisez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner un menu ou choisir l’orientation du bloc.
Tapez sur [ ] pour sélectionner ou annuler.

Jungmumun
Ce jeu exige une habileté de réaction instantanée dans 
lequel vous devez retirer la pierre selon la direction 
gravée sur la fl èche.
Utilisez les touches [Haut, Bas, Gauche, Droite] et [ ]
pour retirer la pierre.

Food King
Il s’agit d’un jeu cérébral qui vous demande de 
préparer de la nourriture autant que vous pourrez 
en modifi ant l’ordre de trois blocs visant à apparier 3 
directions; de largeur, longueur et en diagonale. 
Utilisez la touche [Gauche, Droite] pour déplacer un bloc.
Utilisez la touche [Haut] pour changer la position d’un bloc.
Tapez sur la touche [Bas] pour faire tomber le bloc.

Les jeux peuvent être ajoutés ou remplacés sans avis.
Reportez-vous à la section Help (Aide) pour plus de détails sur la manipulation. REMARQUE
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Prime Pack

Text
Games
Alarm
World Clock

Alarm

New Alarm

POUR RÉGLER L’ALARME 
Le lecteur possède une alarme qui peut être réglée pour se déclencher à 
l’heure voulue.

Avant de démarrer - Réglez la date et l’heure actuelles. 
Reportez-vous à la page 27.

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
l’offre groupée <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Alarm> (Alarme), puis sur [ ].

4. Tapez sur la touche [Haut, Bas] pour sélectionner <New
Alarm> (Nouvelle alarme), puis sur s[ ].

La fenêtre Nouvelle alarme s’affi che.

5. Tapez sur la touche [Haut, Bas] pour sélectionner la 
fréquence de l’alarme, puis sur la touche [Droite].

Sélectionnez parmi : <Once> (Une fois), <Everyday> (Ts 
les jours), <Mon~Fri> (Lun~Ven), <Mon~Sat> (Lun~Sam), 
<Sat~Sun> (Sam~Dim) et <Off> (Arrêt).

6. Tapez sur la touche [Haut, Bas] pour sélectionner la 
fréquence de l’alarme, puis sur la touche [Droite].s

7. Tapez sur la touche [Haut, Bas] pour sélectionner les 
minutes, puis sur la touche [Droite].

8. Tapez sur la touche [Haut, Bas] pour sélectionner <AM> ou <PM>, puis sur 
la touche [Droite].
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POUR RÉGLER L’ALARME (Suite)
9. Tapez sur la touche [Haut, Bas] pour sélectionner une 

sonnerie d’alarme, puis sur la touche [Droite].
Sélectionnez parmi : <Alarm Sound 1> (Son Alarme 1) jusqu’à 
<Alarm Sound 3> (Son Alarme 3), un fi chier musical ajouté 
comme son d’alarme et Radio FM.

10. Tapez sur la touche [Haut, Bas] pour sélectionner un 
intervalle d’alarme, puis sur la touche [ ].

Sélectionnez parmi <Interval : Off>, (Intervalle : Arrêt), 
<Interval : 3min> (Intervalle : 3 min), <Interval : 5min> 
(Intervalle : 5 min) et <Interval : 10min> (Intervalle : 10 min).
La fenêtre de confi rmation de l’enregistrement s’affi che.

11. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), puis 
sur [ ].

Lorsque l’alarme est réglée, le symbole ( ) s’affi chera au haut de la fenêtre.

Vous pouvez enregistrer jusqu’à 7 alarmes.
Le lecteur déclenche l’alarme à l’heure programmée.
Tapez sur [ ] pour arrêter l’alarme.
Lorsque la fenêtre de confi rmation apparaît, tapez sur la touche [Gauche, Droite] 
pour sélectionner <Yes> (Oui), puis sur [ ]. Cette opération permet de quitter 
l’alarme et de revenir au menu principal.

REMARQUE

New Alarm Settings

Once

Alarm Sound 1

Interval : Off

08 00 AM
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POUR RÉGLER L’ALARME (Suite)
Pour modifi er les réglages de l’alarme
1. Tapez sur la touche [Haut, Bas] pour 

sélectionner le réglage à modifi er dans la liste 
des alarmes, puis sur [ ].

La fenêtre Régl. alarme apparaît.

2. Utilisez les touches [Haut, Bas, Gauche, Droite]
et [ ] pour modifi er les réglages de votre choix.

Pour supprimer un réglage d’alarme
1. Tapez sur la touche [Haut, Bas] pour

sélectionner le réglage à supprimer dans la liste 
des alarmes, puis sur [ ].

Le menu supprimer apparaît.

2. Tapez sur [ ].
La fenêtre Supprimer apparaît.

3. Tapez sur la touche [Gauche, Droite] pour
sélectionner <Yes> (Oui), puis sur [ ].

Les alarmes sélectionnées sont supprimées.

Alarm

New Alarm 
08:00 AM

Alarm

New Alarm 
08:00 AM

Delete
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POUR VISUALISER L’HORLOGE UNIVERSELLE
Vous pouvez vérifi er l’emplacement et la date et l’heure de la plupart des 
grandes villes du monde en fonction de leur fuseau horaire.

Avant de démarrer - Réglez la date et l’heure actuelles. Reportez-vous à la page 27.
Réglez le fuseau horaire souhaité dans <Settings> (Paramètres) <Time> (Heure) 
<Time Zone> (Fuseau hr).

1. Appuyez longuement sur [ ] pendant un court moment 
pour vous déplacer vers le menu principal.

2. Tapez sur la touche [Gauche, Droite] pour sélectionner 
l’offre groupée <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner <World 
Clock> (Horl. mond.), puis sur [ ].

L’écran <World Clock> (Horl. mond.) apparaît.

4. Tapez sur la touche [Gauche, Droite] pour sélectionner 
un fuseau horaire.

Vous pouvez vérifi er l’heure locale du fuseau horaire suivant.
(‘/ ’ indique le fuseau horaire normal de la région)
Cape Verde / London, Lisbon / Rome, Paris, Berlin, Stockholm, Madrid, Frankfurt/ 
Athens, Helsinki, Cairo, Ankara / Moscow, Riyadh / Abu Dhabi, Muscat / Tashkent, Ashgabat /
Alma Ata, Kathmandu / Bangkok, Jakarta, Rangoon / Hongkong, Beijing, Manila, Singapore /
Seoul, Tokyo, Pyongyang / Guam, Sydney, Brisbane / Okhotsk / 
Wellingtons, Oakland, Fiji / Samoa, Midway / Honolulu, Hawaii, Tahiti / Alyeska / 
Los Angeles, San Francisco, Vancouver, Seattle / Denver, Phoenix, Salt Lake City / 
Chicago, Dallas, Houston, Mexico City / New York, Miami, Washington DC, Montreal, Atlanta /
Caracas, LA Paz, Santiago / Buenos Aires, Brasilia, Sao Paulo / The middle Atlantic 

Prime Pack

Text
Games
Alarm
World Clock
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dépannage
Si vous rencontrez un problème avec votre lecteur MP3, trouvez une 
solution sur cette liste. Si le problème persiste, contactez le centre de 
service à la clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allume pas si la pile est complètement 
à plat. Rechargez la pile et remettez l’appareil sous 
tension.

• Appuyez sur la touche Reset (Réinitialisation).

Les touches ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur est dirigé 
dans le sens de la fl èche.

• Confi rmez que vous avez appuyé sur la bonne 
touche, puis essayez à nouveau.

• Appuyez sur la touche Reset (Réinitialisation).

L’écran ne s’allume 
pas.

• Il se peut que les données affi chées à l’écran ne 
soient pas visibles sous les rayons directs du soleil.

• Si vous sélectionnez <Display Off> (Écran désactivé) 
du menu <Settings> (Paramètres) <Display>
(Affi cher), l’écran demeure éteint. Tapez sur une 
touche pour voir s’il s’allume.
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PROBLÈME SOLUTION

L’alimentation est 
coupée.

• Vérifi ez l’état de la pile.
• L’alimentation se coupe automatiquement lorsque la 

pile est complètement à plat. Rechargez la pile.
• Si vous sélectionnez <Auto Power Off> (Extinction 

auto) dans <Settings> (Paramètres) <System>
(Système), le lecteur s’éteint lorsqu’il est en mode 
Pause. Allumez le lecteur.

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• La durée de la pile peut varier en fonction du mode 
sonore et des réglages de l’écran.

• La durée de la pile peut être réduite si vous exposez 
l’appareil à des températures basses ou élevées 
pendant des périodes prolongées.

Défaillance du 
programme Media 
Studio

• Confi rmez que votre ordinateur possède les 
caractéristiques fondamentales.

La connexion à 
l’ordinateur est 
désactivée.

• Vérifi ez si la fi che USB est bien branchée et 
réessayez.

• Cliquez sur le bouton <Start> (Démarrer) de la 
barre d’outils de votre ordinateur pour lancer la 
mise à jour de Windows. Sélectionnez les mises à 
jour principales et les ensembles de modifi cations 
provisoires (Service Packs), puis mettez tout à jour. 
Redémarrez votre ordinateur et rebranchez l’appareil.

Le transfert de 
fi chier s’effectue trop 
lentement.

• Le transfert est plus lent si votre ordinateur exécute 
simultanément plusieurs programmes incluant <Media 
Studio>. Quittez les programmes inutiles et essayez à 
nouveau.
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PROBLÈME SOLUTION

Le lecteur n’effectue 
pas la lecture.

• Vérifi ez que le fi chier disponible a bien été enregistré 
dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas endommagé.
• Vérifi ez que la puissance de la batterie est suffi sante.

Le téléchargement de 
fi chiers ne fonctionne 
pas.

• Assurez-vous que le câble USB est bien branché.
Rebranchez si nécessaire.

• Assurez-vous qu’il reste de l’espace disponible sur la 
mémoire.

• Appuyez sur la touche Reset (Réinitialisation).

Des fi chiers ou des 
données manquent.

• Vérifi ez si le câble USB a été débranché durant 
le transfert du fi chier ou des données. Si tel est le 
cas, les fi chiers/données mais également l’appareil 
risquent d’être endommagés. Vous devez faire preuve 
d’une extrême prudence à cet égard car Samsung 
ne saurait en aucun cas être tenu responsable de la 
perte des données.

Affi chage anormal de la 
durée de lecture.

• Confi rmez que le fi chier est au format VBR (débit 
binaire variable).

Affi chage anormal du 
nom de fi chier.

• Aller à <Settings> (Paramètres) <Language>
(Langue) <Contents> (Sommaire) de l’écran du 
menu principal et sélectionnez la langue appropriée.

L’appareil est chaud.
• Les phases de chargement peuvent générer de la 

chaleur. Cela n’a aucune incidence sur la durée de 
vie de l’appareil ou sur son fonctionnement.

Un message apparaît 
pendant que vous 
visionnez une vidéo.

• Tentez de télécharger le clip vidéo à nouveau avec 
Media Studio.
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annexe
ARBRE INVERSÉ DU MENU
Voici un coup d’oeil rapide sur la répartition des menus et des fonctions de votre 
nouveau lecteur MP3.

Écran de sélection du menu

Music Videos Pictures FM Radio Datacasts Prime Pack File Browser Settings

Text Menu
Style

Games Sound

Alarm Display

World Clock Language

Time

System
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-S3
Caractéristiques nominales 5,0 V CC / 500 mA
Built-in Battery Power 580 mAh/ DC 3,7V

Fichier Compatibilité

AUDIO : MPEG1/2/2,5, couche 3 (8 kb/s à 320 kb/s, 
8 kHz à 48 kHz) WMA (48 kb/s à 192 kb/s, 8 
kHz à 48 kHz)

VIDÉO : SVI (Vidéo : MPEG4, Audio : MP3 (44,1 kHz, 
128 kb/s), Résolution : 208X176, 
Images/sec. : 15 i/sec.)

IMAGE : JPG (Balayage progressif, séquentiel, taille 
de fi chier :  inférieure à 3 Mo)

Nombre de fi chiers pouvant 
être accueillis 5 000 max (dossier compris)

Sortie des écouteurs 20 mW/canal. (sur 16 )
Bande de fréquences de la sortie 40Hz~20kHz

Rapport signal sur bruit 90 dB avec fi ltre passe bas 20 kHz (sur la base de 
1 kHz, 0 dB)

Durée de lecture
Maximum de 25 heures d’écoute de musique, 
Maximum de 4 heures de lecture vidéo
(selon : MP3 128 kb/s, Volume : 15, mode Normal)

Plage de températures de 
fonctionnement -5~35°C (23~95°F)

Étui Revêtement métallique, plastique
Poids 53g
Dimensions (L x H x P) 44 X 95 X 9,8 mm

Radio FM
Fréquence FM 87,5~108,0MHz T.H.D. FM 1%
Rapport signal FM 55 dB Sensibilité FM utile 38dB

• Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré sans 
notifi cation préalable.

• Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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LICENCE
L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence 
sous certains droits de propriété intellectuelle de parties tierces. Cette licence 
est limitée à une utilisation privée non commerciale par l’utilisateur fi nal pour les 
contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue 
à un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 
11172-3 ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou 
décoder des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des 
fonctions du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou 
ISO/IEC 13818-3.



Garantie Limitée Samsung
Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.
SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant la 
période de garantie et qu’il s’agit d’un défaut de fabrication SECA se réservera le droit 
de réparer ou de remplacer l’appareil défectueux
Toutes les réparations sous garantie doivent être effectuées par un Centre de service 
autorisé SECA. Le nom et l’adresse du Centre de service le plus près de chez vous 
peut être obtenu en composant sans frais le 1-800-726-7864 ou en visitant notre site 
web au www.samsung.ca

 Main-d’oeuvre Pièces

 un (1) an (au comptoir) un (1) an

Pour tous les modèles portatifs, le transport de l’appareil sera la responsabilité du 
client. Le reçu de vente original doit être conservé par le client car cela constitue sa 
seule preuve d’achat acceptée. Il doit le présenter au Centre de service agréé au 
moment où il fait la demande d’une réparation sous garantie.
Exclusions
Cette garantie ne couvre pas les dommages causés par un accident, un incendie, une 
inondation, un cas de force majeure, un mauvais usage ou une tension incorrecte. La 
garantie ne couvre pas aussi une mauvaise installation, une mauvaise réparation, une 
réparation non autorisée et tout usage commercial ou dommages survenus durant le 
transport. Le fi ni extérieur et intérieur de même que les lampes ne sont pas couverts 
par cette garantie. Les ajustements par le client qui sont expliqués dans le guide 
de l’utilisateur ne sont pas couverts en vertu de cette garantie. Cette garantie sera 
automatiquement annulée pour tout appareil qui aurait un numéro de série manquant 
ou modifi é. Cette garantie est valable seulement sur les appareils achetés et utilisés 
au Canada.
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Si vous avez des suggestions ou des questions concernant les produits 
Samsung,

veuillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service à la Clientèle
1-800-SAMSUNG (7267864)

www.samsung.com/ca


